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法律資訊

重要資訊

德州儀器概不提供有關任何程式或書籍資料的明示或暗示保證，包括但不限
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無論任何情況，德州儀器皆不負責與購買或使用這類資料有關或所致的任何
特殊、附屬、附帶或衍生損害賠償，且無論行動的形式，德州儀器的唯一責任
不會超過本產品的採購價格。此外，德州儀器不承擔任何種類的賠償責任，
不管是否有任何其他當事人因使用這些材料而索賠。

此繪圖產品應用程式 (APP) 已獲授權。請參閱授權合約的條款。

© 2006 - 2020 Texas Instruments Incorporated

Windows、NT、Microsoft、Apple 和 Macintosh均為其各別擁有者的註冊商標。
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新增功能

TI Connect™ CE Software v5.6.0 的新增功能

支援啟用 Python 的 CE計算機

Python (*.py) <--> Python AppVar (*.8xv) 轉換器

將 Python程式電腦檔案 (*.py) 轉換為 CE Python AppVar (*.8xv) 檔案，並傳送到
您的 CE，以便在 TI-84 Plus CE Python App中使用。在 TI-84 Plus CE 上建立的
Python程式 (AppVar) 可以作為 *.py或 *.8xv檔案儲存到您的電腦。

瞭解更多

使用最新的 CE Bundle 進行更新，請轉到：

- education.ti.com/84ceupdate
- education.ti.com/84cetupdate

新增功能 1
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2 TI Connect™ CE軟體簡介

TI Connect™ CE軟體簡介

TI Connect™ CE 軟體讓繪圖計算機和電腦之間的資訊交換變得快速而輕鬆。

支援的 TI 繪圖計算機

支援任何具備 USB 連接埠的 TI-8x繪圖計算機，其機型包含：

• TI-84 Plus CE

• TI-84 Plus CE-T Python Edition* & TI-84 Plus CE-T

• TI 84 Plus C Silver Edition

• TI-84 Plus .

• TI-84 Plus T

• TI-83 Premium CE Edition Python & TI-83 Premium CE

• TI-83 Plus.fr

• TI-82 Advanced

*附註：TI-84 Plus CE 系列計算機將顯示為 TI-84 Plus CE。

附註：對僅有 I/O 連接埠的計算機，請使用 TI Connect™ 4.0。此軟體支援的機型
為：

• TI-83 Plus

• TI-89 Titanium

• Voyage™ 200

• TI-73 Explorer™



使用 TI Connect™ CE軟體

TI Connect™ CE 軟體包含可以用於計算機和電腦之間作為您傳輸檔案的工具。

TI Connect™ CE 軟體包含三個工作區：

• Screen Capture (螢幕擷取)：讓您管理螢幕擷取

• Calculator Explorer (計算機瀏覽器)：讓您管理計算機內容

• Program Editor (程式編輯器)：讓您管理 TI Basic程式

使用 TI Connect™ CE軟體 3



4 使用 TI Connect™ CE軟體

TI Connect™ CE軟體的各個部分

Menu Bar (功能表列) - 使用這些功能表來管理計算機檔案和螢幕、檢
視計算機資訊，並且取得協助。

Toolbar (工具列) - 使用這些圖示來管理電腦檔案和螢幕。

Workspace Panel (工作區面板) - 使用此面板來選取工作區 (螢幕擷取、
計算機瀏覽器和程式編輯器)。

Calculator List Panel (計算機清單面板) - 使用此清單來檢視所有已連接
計算機，並用來選取一個計算機供顯示之用。



Content Panel (內容面板) - 使用此面板來檢視和管理已連接計算機上
的計算機檔案與螢幕。

附註：您可以將這些功能表拖曳至已連接計算機或電腦，藉此完成這
些功能表中大多數的作業。

使用 TI Connect™ CE軟體 5



6 使用螢幕擷取工作區

使用螢幕擷取工作區

螢幕擷取工作區能讓您管理計算機螢幕擷取。

附註：在連接以進行 Screen Capture 之前，先在螢幕上顯示 Screen Capture 工作
區。

接下來，連接計算機以擷取計算機的目前螢幕。

如果螢幕中顯示了其他工作區( 如 Calculator Explorer) ，則當計算機連接時，計
算機將顯示 Home Screen。您必須重新顯示所需的計算機螢幕才能進行螢幕擷
取。



螢幕擷取工作區的各個部分

Menu Bar (功能表列) - 使用這些功能表來管理檔案和影像、檢視計算機資訊，
並且取得協助。

附註：您可以從內容面板拖曳項目，藉此完成這些功能表中大多數的作
業。

Toolbar (工具列) - 按一下這些圖示來儲存、傳送、複製、刪除和調整檔案大
小。

將檔案儲存至電腦。

將檔案傳送至計算機。

複製檔案。

刪除檔案。

新增或移除所有擷取螢幕的邊界。

變更所有擷取螢幕的大小。

檢視螢幕擷取大小。

內容面板 - 在內容面板中檢視螢幕擷取。

擷取和使用螢幕

在螢幕擷取工作區中，您可以擷取並檢視計算機的螢幕。

使用螢幕擷取工作區 7



8 使用螢幕擷取工作區

開始之前

將計算機連接至電腦，確定電腦顯示於計算機清單面板中。

擷取計算機螢幕

1. 在 TI Connect™ CE 軟體工作區面板上，按一下 Screen Capture (螢幕擷取) 工
作區。

2. 在計算機上顯示您要擷取的螢幕。

3. 在計算機清單面板中，按一下想要擷取的計算機旁的 。

• 如果連接了一部以上的計算機，按一下 CONNECTED CALCULATORS (連接的

計算機) 旁的 來擷取所有計算機的螢幕。

將計算機螢幕儲存為檔案

螢幕擷取工作區能讓您將計算機擷取的影像或現有的影像儲存為 PNG 檔。

附註：影像名稱最前方的星號表示該影像並未儲存。

儲存現有的螢幕

1. 在內容面板中，按一下擷取的螢幕。

2. 按一下 。

儲存多個螢幕

1. 按一下 Edit > Select All (編輯 > 全選)。

2. 按一下 。

重新命名螢幕擷取

1. 將游標放在螢幕名稱欄位的最前方。
例如：Capture 1。

2. 連按兩下名稱來選取它。

3. 輸入電腦檔案的新名稱。

將新的螢幕擷取儲存為 PNG 檔案

1. 按一下影像。



2. 按一下 。

3. 瀏覽至想要儲存的位置。

4. 使用預設的檔案名稱或輸入新的檔案名稱。

5. 按一下 。

將螢幕擷取傳送至連接的計算機

這項僅限螢幕擷取的功能提供了下面操作方式：可在高解析度計算機上執行
圖形的螢幕擷取、裁切繪圖區，然後僅將繪圖區轉換為背景影像。勾選 Graph
Area Only (僅限繪圖區) 來建立此類型的背景影像。

1. 如果您尚未擷取螢幕，請先擷取螢幕。

2. 按一下螢幕擷取以選取該影像。

3. 按一下

• FILE NAME (檔案名稱)：這可能與 NAME ON CALCULATOR (計算機上的名稱)
不同，端視您在電腦上對此螢幕擷取的命名而定。

• NAME ON CALCULATOR (計算機上的名稱)：選取背景影像 (應為預設值，但
您可以使用此功能表來變更背景影像)。

附註：螢幕擷取和轉換的影像檔案將以圖片變數的格式傳送至灰階計算
機。

• GRAPH AREA ONLY (僅限繪圖區)：在右側面板中，選擇您是否只要傳送繪圖
區，或傳送整個螢幕。將螢幕擷取傳回計算機時，最好僅傳送繪圖區。

裁切影像

繪圖區的螢幕擷取包含 TI-84 Plus CE 的整個螢幕、狀態列、繪圖邊界和繪
圖區。

使用螢幕擷取工作區 9



10 使用螢幕擷取工作區

TI Connect™ CE 軟體能讓您裁切影像為「僅限繪圖區」的大小來建立「背景
影像變數」。您可以在「傳送至計算機」對話方塊內的「傳送至」欄位，將螢
幕裁切為「僅限繪圖區」的大小。

• DESTINATION CALCULATORS (目的地計算機)：選擇您是否要傳送影像至所有
連接的計算機，或僅傳送至所選的計算機 (從檢查清單選取)。

傳送檔案至多個計算機

1. 選取對話方塊上的 Select Calculators (選取計算機) 按鈕。

2. 勾選您要選取的計算機旁的方塊。

3. 按一下 Send (傳送)。

將螢幕擷取拖曳至電腦應用程式

使用螢幕擷取工作區，您可以將擷取的螢幕拖曳至許多電腦應用程式中。此
功能可讓您在文件中使用從計算機上所擷取的螢幕。

將螢幕拖曳至電腦應用程式中

1. 開啟或擷取螢幕。

2. 將螢幕拖曳至開啟的文件或簡報用的電腦軟體應用程式。

附註：您也可以使用 Edit>Copy>Paste (編輯 > 複製 > 貼上)，將其放置在開啟的
文件或簡報人員的電腦軟體應用程式內。



使用計算機瀏覽器工作區

計算機瀏覽器工作區可讓您管理計算機內容。

使用計算機瀏覽器工作區 11



12 使用計算機瀏覽器工作區

計算機瀏覽器主工作區的各個部分

Menu Bar (功能表列) - 使用這些功能表來管理檔案和影像、檢視計算機資訊，
並且取得協助。

附註：您可以從內容面板拖曳項目，藉此完成這些功能表中大多數的作
業。

Toolbar (工具列) - 按一下這些圖示來新增、傳輸或刪除來自計算機的檔案。

新增來自電腦的內容

將選取的內容傳送至電腦。

將選取的內容傳送至另一部已連接的計算機。

刪除選取的檔案。

重新整理已連接計算機上的內容檢視。



Content Panel (內容面板) - 選取您要從此面板管理的檔案。

選取已連接的計算機

TI Connect™ CE 軟體可讓您同時連接多部計算機。按一下以選取您要使用的計
算機。選取的計算機會成為所有 TI Connect™ CE 軟體作業的預設計算機。

開始之前

將計算機連接至電腦，確定電腦顯示於計算機清單面板中。

將計算機檔案複製到電腦

您可以將大部分的資料、檔案和程式從計算機複製到電腦，用來做為內容備
份、傳送給他人或釋放計算機記憶體。

從計算機複製檔案至電腦

1. 按一下以選取檔案名稱。

2. 將檔案拖曳到電腦上的資料夾內，或拖曳到桌面上。

從計算機複製檔案至電腦做為內容備份

1. 選取 Edit (編輯)

2. 選取 All (全部)

3. 將檔案拖曳到電腦上的資料夾內，或拖曳到桌面上。

附註：此處沒有自動備份功能。

使用計算機瀏覽器工作區 13



14 使用計算機瀏覽器工作區

警告：傳輸進行時，切勿拔除傳輸線。

從電腦複製檔案至計算機

1. 在電腦上瀏覽至所需的檔案。

2. 將檔案拖移至計算機清單面板，將滑鼠游標移至想要的計算機上方。

3. 當您看見 時，釋放滑鼠按鈕。

4. 從下拉式功能表選取檔案名稱。這會成為計算機上的檔案名稱。

5. 按一下 Send (傳送)。

傳送檔案至已連接的計算機

您可以將檔案傳送至已與 TI Connect™ CE 軟體連接的計算機。

警告：傳輸進行時，切勿拔除傳輸線。

傳送檔案至已連接的計算機

1. 按一下內容面板中的檔案來選取它。

2. 按一下 。

• DESTINATION CALCULATORS (目的地計算機)：選擇您是否要傳送檔案至所有
連接的計算機，或僅傳送至所選的計算機 (從檢查清單選取)。

傳送檔案至所選的計算機

1. 選取對話方塊上的 Select Calculators (選取計算機) 按鈕。

2. 勾選您要選取的計算機旁的方塊。

3. 按一下 Send (傳送)。

轉換和傳送背景影像

TI-84 Plus CE 可顯示背景影像和圖片變數。這些變數會顯示在繪圖區中。



附註：背景影像上的所有資訊亦適用於 TI-84 Plus C Silver Edition和 TI-83
Premium CE。

使用背景影像

TI Connect™ CE 軟體會自動將傳送至已連接計算機的任何影像轉換為背景影像
變數。由於轉換的像素尺寸為 83 x 133，您的影像在繪圖區中顯示的情況可能
會與預期的不同。

附註：如需得到最佳結果，請先將您的影像比例編輯為 83 x 133像素，再
轉換為 83 x 133像素。

提示！嘗試如下所述轉換影像。若轉換結果不符合您的預期要求，請將圖
片縮放為類似於背景影像變元在CE上顯示的圖形區域。

• 使用畫面擷取工作區以 100% 比例擷取圖形畫面。此擷取畫面可以是
「全螢幕」或「圖形-表」模式。您將使用此功能將影像縮放到較小的尺
寸以適合圖形區域的大小。

• 使用偏好的簡報軟體，並同時顯示擷取畫面和圖片。

• 將圖片拖曳( 調整) 為較小的尺寸和圖形區域的比例。

• 使用截圖工具擷取新的較小影像。將該影像儲存到電腦。

• 使用此較小的比例圖片，依照以下步驟轉換為影像變元。

提醒您！使用較小圖片的不同電腦檔名保留原始圖片檔。

背景影像變數轉換作業使用的是 16位元色彩。

您也可以將背景影像變數上傳至 TI-SmartView™ CE 軟體中的 TI-84 Plus CE 模擬
器檢視。

在 TI-84 Plus CE 上，背景影像變數僅會在繪圖區中顯示為背景。背景影像會配
合全螢幕、水平、和繪圖表格等「模式」的螢幕設定，調整其顯示方式。這樣可
保存任何在背景完成的數學模式建立。您無法在使用 TI-84 Plus CE 時編輯背
景影像。背景影像會從歸檔記憶體執行並儲存於歸檔記憶體中。

使用計算機瀏覽器工作區 15



16 使用計算機瀏覽器工作區

將背景影像傳送至連接的計算機

您可以傳送背景影像並在 TI-84 Plus CE 的繪圖區內顯示。

附註：背景影像上的所有資訊亦適用於 TI-84 Plus CE-T、TI-84 Plus C Silver Edition
和 TI-83 Premium CE。

1. 開啟 TIConnect™ CE 軟體。

2. 選擇計算機瀏覽器工作區。

3. 使用傳輸線將 TI-84 Plus CE 連接到電腦。

4. 開啟 TI-84 Plus CE。

5. 選擇您要轉換的影像。

6. 將照片拖移至計算機清單面板，將滑鼠游標移至想要的計算機上方。

7. 當您看見 時，釋放滑鼠按鈕。

8. 從下拉式功能表選取 Image# 名稱 (Image0 - Image9)。這會成為 TI-84 Plus CE
上的影像名稱。

附註：您選擇的 Image# 名稱會成為計算機上的影像名稱。當您想要傳送
或共用此檔案時，記下此 Image# 名稱 (或使其成為電腦上檔案名稱的一
部分) 可供識別之用。

警告：預先載入的影像會儲存在 Image1 - Image5之中。使用其他 Image# 以
避免覆寫預先載入的影像。

9. 按一下 Send (傳送)。

重新命名電腦檔案，如此您便可在稍後識別您的影像變數 (橋墩、噴水池等)。
Image# 內部計算機變數名稱不會被改變。

若要儲存背景影像至您的電腦，則將 Image# 從計算機瀏覽器拖移到您的桌
面上，或拖移到您想要儲存背景影像的資料夾裡。

• 若要在 TI-84 Plus CE 的繪圖區中顯示新的背景影像，請按下y.，將
Background (背景) 設定變更為您剛剛傳送至計算機的 Image# (例
如：Image5)，然後按下s。

附註：從計算機上的繪圖螢幕，您也可以使用 [draw]; BACKGROUND;
1:BackgroundOn互動式命令來變更背景。



資料匯入

資料匯入功能可讓您將試算表轉換儲存為 csv資料檔案並傳送至計算機，成
為計算機清單或矩陣檔案。

從計算機瀏覽器工作區取用資料匯入功能。

特色：

• 建立 (或下載) 資料試算表。

• 開始匯入前，請先使用您的試算表軟體進行資料編輯，使其僅含計算機所
允許的數字格式 (指定如下) ，以便匯入計算機檔案。

關於試算表

• 每次僅有一個儲存為 CSV (逗號分隔 ) (*.csv) 的試算表檔案會透過計算機瀏
覽器工作區匯入。

• 您可以將試算表 (csv) 檔案拖移至計算機瀏覽器中，或透過 Actions > Import
Data (.csv) to List/Matrx... (作業 > 將資料 (.csv) 匯入清單／矩陣 ...) 功能表匯
入。

• 試算表資料當中最多有 6份計算機清單或 1個矩陣傳送至連接的計算
機。

準備試算表以便匯入的規則為：

• 所有儲存格必須包含計算機上所使用的相同實數資料，不得有文字。

- 資料匯入不支援複數。

- 如果在 *.csv檔案中使用逗號表示十進位數字，則該檔案將無法用 Data
Import Wizard進行轉換。請檢查您的電腦作業系統數字格式，並轉換
*.csv以使用小數點表示十進位數字。CE 計算機串列和矩陣編輯器使用
小數點表示十進位數位( 例如 12.34) ，而不是逗號( 例如 12,34) 。

• 資料必須從 A1儲存格開始。

使用計算機瀏覽器工作區 17
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• 匯入清單：如果需要計算機清單：

- 僅會匯入六個試算表資料欄 (A-F)。
- 資料欄長度最多可達 999個儲存格。

- 資料欄中第一個空白儲存格會被視為該筆清單匯入的資料結尾

• 矩陣匯入：如果需要計算機矩陣：

- 僅有一個矩陣可以從試算表檔案匯入。

- 最多可匯入 400個儲存格。(例如：資料列 x資料欄：10 x 5 = 50個儲存
格，來自資料列範圍 1-10、資料欄 A-E。)

- 在計算機瀏覽器當中進行匯入的期間，系統會要求矩陣維度的形式
(資料列 x資料欄)。

- 指定的矩陣維度內任何留空的儲存格均會被視為 0。

• 請勿於試算表中清單允許的大小或上述矩陣以外的位置存放資料。否則，
當您試圖將資料匯入計算機瀏覽器時，檔案會變成無效。

儲存計算機清單或矩陣檔案

• 若要儲存專為電腦建立的計算機檔案，請在匯入／傳送至計算機之後，將
清單或矩陣檔案從計算機瀏覽器拖移至所需的電腦位置。



刪除計算機檔案

您可以從計算機刪除資料、檔案和程式。

從計算機刪除檔案

1. 在內容面板中，按一下您要刪除的檔案。

2. 按下 ·

退出測驗模式中設定在連接 CE計算器

退出測驗模式中設定在 ce 通過將 CE 計算器( S )到您的電腦並選擇

• 動作>退出測驗模式中已連接的 TI Connect™ CE CE 計算器。

使用最新的 CE Bundle 進行更新，請轉到：

- education.ti.com/84ceupdate
- education.ti.com/84cetupdate

使用計算機瀏覽器工作區 19
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轉換及傳送 Python 程式以在 Python App 中使用

將 Python程式轉換為 Python AppVar

當 CE 計算機支援 Python程式設計，則使用 TI Connect™ CE 將檔案傳送到使用
Python的 CE 計算機或 CE 計算機使用 TI Connect™ CE 時，電腦中的 Python程式
(*.py) 將轉換為 Python AppVar (*.8xv)。然後，使用適用於您的計算機的 Python
App，即可編輯和執行 Python程式。

提醒您：對於任何電腦/TI-Python體驗：在電腦上的 Python開發環境中創建
Python程式後，請在 TI-Python體驗中驗證程式在計算機/模擬器上的執行情
況。根據需要修改程式。

有關 TI-Python的詳細資訊，請參閱 Python App電子指南。

使用 Send to Calculators 傳送 *.py程式檔案的操作，與將任何其他檔案發送到
計算機的操作類似。

FILE NAME(檔案名稱 )：顯示 *.py檔案的電腦檔案名稱。

附註：這可能與 NAME ON CALCULATOR不同，依您在電腦上對此 Python程
式的命名而定。

NAME ON CALCULATOR(計算機上的名稱 )：

• 如果電腦檔案名稱遵循 Python AppVar命名規則，則將用電腦檔案名稱填
充 Python AppVar計算機名稱。命名規則顯示在上面的螢幕上。

- 小寫字母將自動更改為大寫字母。

• 如果電腦檔案名稱未遵循 Python AppVar命名規則，則 NAME ON
CALCULATOR將填充為 PYTHON01、PYTHON02等。

• 使用下拉選單中的 Custom 命名選項更改 NAME ON CALCULATOR。必須遵循
Python AppVar的命名規則。

LOCATION(位置 )：

• 選擇將 Python AppVar傳送到計算機的 RAM或存檔記憶體。

- 預設值為 RAM。

- Python App將僅在 RAM中編輯和運行 Python AppVar。

• 若存在以下情況，則將 Python AppVar儲存在計算機的存檔記憶體中

https://education.ti.com/html/webhelp/EG_TI84PlusCE-T/UK/index.html


- Python App體驗中沒有足夠的記憶體( 如 App中所述) 。
- 在計算機上將 Python AppVar從存檔移動到 RAM之前，不希望看到

Python AppVar載入到 Python體驗中。

附註：要在 CE 上的 RAM和存檔記憶體之間移動 Python AppVar

按yL 2:Mem Management/Delete... > B:Var App…

在每個 AppVar上按 [輸入]，以從 RAM切換到存檔( 用 * 表示) 。

DESTINATION CALCULATORS(目的地計算機 )：

▶ 選擇您是否要傳送程式至所有連接的計算機，或僅傳送至所選的計算機
( 從檢查清單選取) 。

哪個 AppVar是 Python AppVar？

您將能夠按照如下方式識別您的 Python AppVar。

在 TI Connect CE Calculator Explorer中，Python AppVar將顯示為「AppVar Python」。
在這裡，SCRIPT1和 VABSOLUE 是 Python AppVar。

附註：Python AppVar將傳送到其他 8x系列計算機，但無法在這些計算機上訪
問。

按yL 2:Mem Management/Delete...> B:Var App…將在螢幕右側顯示 PY。

將 Python AppVar傳送或轉換到電腦( *.8xv 或 *.py)

可將 Python AppVar作為 Python AppVar (*.8xv) 或 Python程式 (*.py) 從計算機傳
送到電腦。

• 只作為 Python AppVar傳送到電腦：從連接的啟用 Python的 CE 計算機中拖
動一個 Python AppVar，該 Python AppVar將作為 AppVar (*.8xv) 檔案傳送到電
腦。

• 傳送到電腦，並可選擇作為 Python程式傳送 (*.py)：

- 在 Calculator Explorer中選擇一個 Python AppVar。範例：AIRECARR
- 選擇 Actions>Send to Computer
- 儲存到電腦時，選擇 AppVar (*.8xv) 或 Python (*.py) 副檔名。
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附註：

- 將 Python AppVar轉換回 *.py電腦檔案後，請在電腦的 Python軟體
中檢查語法、間距、換行符和 Python特定項。對電腦上正在使用的
Python版本進行必要的修改。Python版本各不相同。

- 將轉換得到的 *.py檔案儲存到電腦時，最好將程式儲存為新的 *.py
檔案名稱，以避免覆寫原始 *.py程式。

提醒您：對於任何電腦/TI-Python體驗：在電腦上的 Python開發環境中創建
Python程式後，請在 TI-Python體驗中驗證程式在計算機/模擬器上的執行情
況。根據需要修改程式。

有關 TI-Python的詳細資訊，請參閱 Python App電子指南。

https://education.ti.com/html/webhelp/EG_TI84PlusCE-T/UK/index.html


使用程式編輯器工作區

程式編輯器工作區能讓您使用 TI Basic程式。

使用程式編輯器工作區 23



24 使用程式編輯器工作區

程式編輯器工作區的各個部分

Menu Bar (功能表列) - 使用這些功能表來管理檔案和程式，並且取得
協助。

附註：在程式編輯器工作區中，您僅能將程式拖曳至內容面板。

Toolbar (工具列) - 按一下這些圖示來存取建立新程式、開啟程式、儲
存程式至電腦、傳送程式至已連接的計算機、還原或重做以及字體大
小調整桿等功能。

建立新程式。

開啟程式。

儲存程式至電腦。



傳送程式至已連接的計算機。

還原或重做。

字體大小調整桿可增加或減少下列功能的文字大小：

• 目錄面板

• 程式編輯器

Content Panel (內容面板) - 使用此面板來建立、檢視和編輯程式。

Catalog Panel (目錄面板) - 使用此面板來選取您的計算機類型，然後從
目錄樹狀圖清單 (依照目錄) 選擇以建立程式。

使用程式編輯器工作區 25
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Syntax Reference Panel (語法參照面板) - 使用此面板來檢視每道命令的
適當語法，另亦一併檢視必要和選用的引數。

建立新程式

未開啟任何程式時，內容面板僅會顯示「新增程式」和「開啟程式」圖示。

建立新程式

▶ 按一下 New Program (新增程式) 圖示。

開啟現有的程式

1. 按一下 Open Program (開啟程式) 圖示。

2. 瀏覽至適當的資料夾。

3. 按一下 Open (開啟)。

編輯變數名稱

新的程式名稱為 PROG##。其數字按照順序漸增，例如：PROG01、PROG02，依
此類推。

變更程式名稱

▶ 在 Var Name (變數名稱) 方塊內按一下，並輸入最多 8個字母或數字的新
名稱 (開頭不得為數字)。

保護您的程式

TI Connect™ CE 軟體可讓您保護程式，使其傳送至已連接的計算機後不會被編
輯。

保護您的程式

▶ 勾選鎖頭圖示旁的核取方塊。

將程式儲存至電腦

程式名稱最前方的星號表示該程式尚未儲存。



儲存程式

1. 按一下 。

2. 瀏覽至適當的資料夾。

3. 按一下 Save (儲存)。

關閉程式

關閉程式

▶ 按一下程式名稱旁的 x。

使用程式編輯器工作區 27
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使用目錄面板

目錄面板包含您可以用來建立程式的計算機命令、函數、變數和符號清單。

展開或縮合目錄層級

▶ 按一下每個目錄項目旁的三角形符號。

將目錄項目放置在內容面板中

▶ 將目錄項目拖曳至內容面板中。如此會在拖放項目後，將游標放置在程式
編輯器命令行中。

-或是-



▶ 連按兩下目錄項目。這樣會將項目貼上程式編輯器，而焦點仍會維持在目
錄面板以選取其他項目。回到命令行結尾處，按一下以繼續在編輯器中輸
入。

避免語法錯誤

使用命令和符號的目錄，將其貼至編輯器上，以避免因命令中不正確使用大
小寫而導致語法錯誤。

範例：

您輸入的是 Eval( 或 eval(？

您輸入的是 sin( 或 Sin(？

目錄樹狀圖
清單 貼上 正
確的大小寫
和空格格
式。

額外空格語法錯誤

在計算機上執行程式

當程式在計算機上執行時，額外空格可能造成語法錯誤。
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額外空格在哪裡？

您可以在程式中使用 TI Connect™
CE 程式編輯器，選取整個程式即可
看見額外空格。命令行結尾處的額
外空格應在傳送程式至計算機前
刪除。

當程式在計算機中執行時，如果有額外空格，從語法錯誤螢幕選取 Goto (跳
至) 會將游標放置在出現錯誤的程式行上。檢查該行是否為正確語法，且是否
在命令行結尾處有多餘空格。

• 將游標移至該命令行的結尾處。

• 仔細刪除額外的空格。

附註：計算機上沒有還原功能。



命令何時會變成計算機命令 (Token)？

命令不會變成計算機命令 (token)，直到將程式傳送至計算機為止。

當您的程式傳送至計算機或在計算機上執行時出現錯誤，請檢查計算機程式
編輯模式中每一道命令是否確實為命令 Token。

如何得知？

當命令在計算機上為 Token時，游標會放置在第一個字元上，然後跳過是
Token的命令。如果游標依照字元逐一移動通過命令，則該命令並未轉換。刪
除並貼上來自計算機的命令。

提醒您：直接在計算機上輸入程式時，命令或函數會做為 Token完全貼上。

警告：有些計算機命令，如 LEFT、CENTER、RIGHT、FRAC，都是您在字串中可能
會使用的文字。如果您在字串中看見與計算機命令相同的文字，您的文字將
成為計算機 Token，並且可能會在程式中發生錯誤。避免使用與 TI-Basic命令
相同的文字或部分文字，避免意外將文字轉成 Token而成為命令。

警告：TI Connect™ CE 的語言設定會決定如何將文字詮釋為計算機的命令
Token。以不同的語言使用 TI Connect™ CE 開啟程式並傳送回計算機，可能會導
致：

• 意外的命令 Token和／或

• 語法錯誤

使用語法參照面板

語法參照面板會顯示每個目錄項目的語法，包含必要與選用的引數。
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HUB功能表 (用於 TI-Innovator™ 和 TI-Innovator™ Rover)
程式編輯器支援用於 TI-Innovator™和 TI-Innovator™ Rover命令的 TI-Innovator™
HUB 功能表。HUB 功能表位於樹狀目錄中的「程式」功能表。TI Connect™ CE 程
式編輯器新增的這個 HUB 功能表的使用體驗，並與在 CE 計算機上載入 HUB
應用程式時的體驗相同。請務必使用最新版本的 CE 作業系統和 CE Hub應用
程式。

附註：如果 Program Editor hub菜單不包含某些最新的 hub命令，請根據需要在
Program Editor中鍵入命令。

使用最新的 CE Bundle 進行更新，請轉到：

- education.ti.com/84ceupdate
- education.ti.com/84cetupdate

另請參閱：

使用目錄面板

將程式傳送至計算機

https://education.ti.com/84ceupdate
https://education.ti.com/84cetupdate


將程式傳送至計算機

您可以將程式傳送至已連接的計算機。

將程式傳送至已連接的計算機

1. 如果您尚未儲存程式，請先儲存程式。

2. 按一下 。

• FILE NAME (檔案名稱)：這可能與 NAME ON CALCULATOR (計算機上的名稱)
不同，依您在電腦上對此程式的命名而定。

• NAME ON CALCULATOR (計算機上的名稱)：選取程式名稱 (應為預設值，但
您可以按一下 Custom (自訂) 來變更程式名稱)。

• LOCATION (位置)：選擇要將程式儲存在計算機的 RAM或歸檔中。

• DESTINATION CALCULATORS (目的地計算機)：選擇您是否要傳送程式至所有
連接的計算機，或僅傳送至所選的計算機 (從檢查清單選取)。

傳送程式至多個計算機

1. 選取對話方塊上的 Select Calculators (選取計算機) 按鈕。

2. 勾選您要選取的計算機旁的方塊。

3. 按一下 Send (傳送)。

語言設定

如果您希望以不同於電腦 OS 語言設定的語言來開發 TI-Basic程式，您可以用
其他語言重新啟動 TI Connect™ CE。

1. 選取 File > Change Language (檔案 > 變更語言)。

2. 重新啟動應用程式後，選取語言變更。
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• QUIT LATER (稍後結束) - 保留選取的語言，而下次啟動 TI Connect™ CE 時，TI
Connect™ CE 將以此選取的語言啟動。

• QUIT NOW (立刻結束) - 關閉軟體應用程式。下次啟動 TI Connect™ CE 時，TI
Connect™ CE 將以此選取的語言啟動。

• CANCEL (取消) - 不進行語言變更。電腦 OS 語言將為預設值。



維護您的計算機

正在更新計算機

TI CE 套裝檔案 – 使用一個電腦檔案即可更新您的 CE 計算機！

使用 TI Connect ™ CE 和 TI CE 產品包，一步一步更新連接的 CE 計算器。

使用最新的 CE Bundle 進行更新，請轉到：

- education.ti.com/84ceupdate
- education.ti.com/84cetupdate

將 CE 計算機連接至 TI Connect™ CE。將適當的 TI CE 套裝拖曳至 Calculator
Explorer。

TI Connect™ CE 將會更新 CE 作業系統、任何需要更新或計算機中遺失的 CE 應
用程式，以及將 5個預先載入的影像變數載入到影像 1 – 影像 5。程序無法停
止，因此請務必使用 TI Connect™ CE Calculator Explorer儲存( 拖曳) 任何您喜愛
的計算機檔案。您可以在新的 TI CE 套裝程序完成後，將最愛的計算機檔案拖
回計算機。

將 CE 套件拖曳至 Calculator Explorer。請耐心等候，直到完成整個程序。傳輸任
何檔案時，切勿拔除傳輸線。可預期 CE 計算機在影像變數和應用程式傳輸之
前重新開機。可預期 CE 計算機有時會在程序期間進行重組( 重新排列記憶
體) 。傳輸時，TI Connect CE 視窗上會顯示訊息。

附註：請勿混淆 TI CE 套裝檔案以及仍可在 education.ti.com 另外下載的 CE 作業
系統和 CE 應用程式檔案。TI CE 套裝包含您更新或還原 CE 計算機時所需要的
所有最新檔案，如同您只購買了計算機，並提供更新班級設定 CE 計算機的快
速方式。

重要訊息：若 CE 計算機螢幕顯示「等待中 ...」，表示計算機遺失了作業系統。
若在檔案傳輸期間從計算機或電腦拔除了傳輸線，則會發生這樣的情況。若
已連接，請先斷開再將 CE 重新連接至電腦。將 CE 套裝拖曳至 Calculator
Explorer。

提醒您：請耐心等候，直到完成整個程序。傳輸任何檔案時，切勿拔除傳輸
線。可預期 CE 計算機在影像變數和應用程式傳輸之前重新開機。可預期 CE
計算機有時會在程序期間進行重組( 重新排列記憶體) 。傳輸時，TI Connect CE
視窗上會顯示訊息。

您可重複此程序，而 CE 套 '裝將會再次傳輸檔案。傳輸任何檔案時，切勿拔除
傳輸線。

另請參閱：

傳送檔案至已連接的計算機
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更新 TI-84 Plus CE 計算器

TI Connect™ CE 軟體可讓您下載繪圖計算機的作業系統。

開始之前

• 備份您的計算機檔案 (RAM、歸檔和應用程式)

• 確保計算機已開機且已穩固地連接電腦。

• 如果您有多部以 USB 電腦傳輸線連接的計算機，OS 傳輸可以指定特定的
計算機。

您可以在「傳送」對話方塊中選取特定計算機來完成這項作業。

警告：傳輸進行時，切勿拔除傳輸線。

更新繪圖計算機作業系統

1. 按一下 Actions > Send OS (作業 > 傳送 OS)。

2. 在您的電腦上，瀏覽至適用於您的計算機機型的正確 OS 檔案。

3. 按一下 Open. (開啟)。

此時會開啟「傳送 OS」對話方塊。

4. 從 Destination Calculators (目的地計算機) 當中選取：



5. 按下「傳送」 。
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取得計算機資訊

TI Connect™ CE 軟體可讓您取得計算機類型、產品 ID、OS 版本、RAM、歸檔、語
言、ROM版本和硬體版本的相關資訊。

附註：計算機資訊僅可從計算機瀏覽器工作區取得。

附註：TI-84 Plus CE 系列將顯示爲 TI-84 Plus CE 。請參閱“支持的 TI 繪圖計
算器”部分中的所有支持的 TI-84 Plus CE 。

檢視計算機資訊

▶ 按一下 View > Calculator Information (檢視 > 計算機資訊)。

繪圖計算機的相容性

退出測驗模式中設定在連接 CE 計算器

退出測驗模式中設定在 ce 通過將 CE 計算器( S )到您的電腦並選擇

動作>退出測驗模式中已連接的 TI Connect™ CE CE 計算器。



一般資訊

線上說明

education.ti.com/eguide

選取您所在的國家以獲取更多產品資訊。

聯絡 TI 支援中心

education.ti.com/ti-cares

選取您所在的國家以獲取技術和其他支援資源。

服務與保固資訊

education.ti.com/warranty

選取您所在的國家，以獲取有關保固期限和條款或產品服務的資訊。

有限保證。這保證不會影響您的法定權利。

更新

education.ti.com/84ceupdate

education.ti.com/84cetupdate
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